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Questa documentazione contiene la descrizione generale e/o le caratteristiche tecniche dei prodotti qui 

contenuti. Questa documentazione non è destinata e non deve essere utilizzata per determinare 

l'adeguatezza o l'affidabilità di questi prodotti relativamente alle specifiche applicazioni utente. Ogni 

utente o integratore deve condurre le proprie analisi complete e appropriate di rischio, la valutazione e il 

test dei prodotti in relazioni all'uso o all'applicazione specifica. Né Schneider Electric né qualunque 

associata o filiale deve essere tenuta responsabile o perseguibile per il cattivo uso delle informazioni ivi 

contenute. Gli utenti possono inviarci commenti e suggerimenti per migliorare o correggere questa 

pubblicazione. 

È vietata la riproduzione totale o parziale del presente documento in qualunque forma o con qualunque 

mezzo, elettronico o meccanico, inclusa la fotocopiatura, senza esplicito consenso scritto di Schneider 

Electric.

Durante l'installazione e l'uso di questo prodotto è necessario rispettare tutte le normative locali, nazionali 

o internazionali in materia di sicurezza. Per motivi di sicurezza e per assicurare la conformità ai dati di 

sistema documentati, la riparazione dei componenti deve essere effettuata solo dal costruttore.

Quando i dispositivi sono utilizzati per applicazioni con requisiti tecnici di sicurezza, seguire le istruzioni 

appropriate. 

Un utilizzo non corretto del software Schneider Electric (o di altro software approvato) con prodotti 

hardware Schneider Electric può costituire un rischio per l’incolumità personale o provocare danni alle 

apparecchiature.

La mancata osservanza di queste informazioni può causare danni alle persone o alle apparecchiature.

© 2010 Schneider Electric. Tutti i diritti riservati.
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Informazioni su...
In breve

Scopo del documento

La guida rapida descrive, mediante un esempio di applicazione, le varie fasi necessarie ad installare, 

configurare e controllare velocemente le partenze motore TeSys U. La guida rapida consente a chi abbia 

un'esperienza di base in materia di PLC e software applicativi (Advantys, Unity Pro) di configurare senza 

difficoltà una rete di comunicazione Advantys STB. A questo scopo non occorre consultare ulteriore 

documentazione. 

Per ulteriori dettagli sulle altre funzioni delle partenze motore TeSys U consultare la documentazione 

elencata di seguito.

Nota di validità

Le informazioni fornite da questa guida rapida si riferiscono ai componenti hardware e software usati 

nell'esempio applicativo illustrato. Le stesse procedure si possono impiegare anche con hardware e 

software di versioni diverse, a condizione che siano compatibili.

Documenti correlati

E' possibile scaricare queste pubblicazioni e tutte le altre informazioni tecniche dal sito www.schneider-

electric.com.

Commenti utente

Inviare eventuali commenti all'indirzzo e-mail techcomm@schneider-electric.com.

Titolo della documentazione Numero di 

riferimento

TeSys U LULC15 Advantys STB, modulo di comunicazione — Manuale d'uso 1744083

Variabili di comunicazione TeSys U — Manuale d'uso 1744082

Partenze TeSys U LUB/LUS — Scheda di istruzioni 1629984

TeSys DFB V2 per Unity Pro - Manuale d'uso 1672609

Modulo di interfaccia Advantys STB standard per reti CANopen - Guida applicativa 31003684
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Introduzione 
Contenuto di questo capitolo

Questo capitolo contiene le seguenti sottosezioni:

Presentazione dell'applicazione

Introduzione

Questo esempio applicativo illustra le fasi che consentono di definire partenze motore ad azionamento 

diretto (DOL) allo scopo di: 

 garantire protezione magnetotermica

 comandare il motore e

 ottenere il segnale di feedback dal contattore e dall'intervento dell'interruttore automatico

Descrizione dell'applicazione

 Motore 1 (M1):

Motore trifase, classe 10, 5,5 kW (7.5 hp) a 440 V, 50 Hz, corrente nominale In = 10,5 A DOL 

 Motore 2 (M2):

Motore trifase, classe 20, 7,5 kW (10 hp) a 440 V, 50 Hz, corrente nominale In = 14,7 A DOL con 

monitoraggio a distanza del carico motore

Soluzione tradizionale

Lo schema seguente mostra il cablaggio di una soluzione tradizionale: tutti i comandi e le informazioni di 

feedback sono cablati attraverso il PLC.

Argomento Pagina
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La soluzione Schneider Electric con le partenze motore Tesys U 6
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Introduzione
La soluzione Schneider Electric con le partenze motore Tesys U

Schemi di alimentazione e comando della soluzione Schneider Electric

Unità di controllo per la soluzione Schneider Electric

La soluzione Schneider Electric presentata in questa guida rapida risponde a diverse esigenze 

applicative utilizzando i moduli TeSys U.

 LUCA12BL è un'unità di controllo standard utilizzata con il motore 1 per svolgere funzioni di base:

 controllo remoto di un motore (start/stop)

 informazioni di stato (pronto, in marcia, errore)

 LUCD18BL è un'unità di controllo avanzato utilizzata con il motore 2, con funzionalità più avanzate 

che si aggiungono a quelle standard:

 allarme

 ripristino automatico e a distanza tramite il bus

 indicazione del carico del motore

 differenziazione degli errori

Schema di alimentazione Schema di comando

1. Modicon M340 - processore BMXP342010 con bus 

master integrato CANopen

2. Connettore TSXCANKCDF90T

3. STBNCO2212 Advantys STB - modulo di interfaccia 

di rete standard verso CANopen

4. Collegamento bobina precablata LU9BN11L

5. LU9RCD10 - Cavo di collegamento bus al primo 

TeSys U

6. LU9RDD10 - Cavo di collegamento bus tra i moduli 

Advantys STB

7. LU9RFL15 - Connettore di fine linea TeSys U

A
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Introduzione
Architettura del sistema TeSys U

L'immagine seguente illustra i componenti principali di un sistema TeSys U montato su pannello:

Legenda Nome commerciale Descrizione

1 Modicon M340 Controllore logico programmabile (PLC)

Isola STB con i componenti elencati di seguito:

2 TSXCANKCDF90T Connettore angolare SUB-D9 CANopen in posizione ON

3 STBNCO2212 Modulo di interfaccia di rete (NIM) con bus CANopen

4 STBPDT3100 Modulo di distribuzione dell'alimentazione STB per 24 V

5 STBDDO3200 Modulo uscite digitali

6 STBXBE1100 Modulo di espansione fine segmento (EOS)

7 LU9RCD10 Cavo di collegamento bus, angolare/diritto, con un connettore per cavo di 

prolunga bus isola su ciascuna estremità, per segnali bus e alimentazione 

interna, da collegare al primo modulo di comunicazione TeSys U (massimo 

1 m (39,4 in.) da tagliare in base alle dimensioni della rete).

8 LUB12 Base di potenza TeSys U

9 LUCA12BL Unità di controllo standard

10, 13 LULC15 Modulo di comunicazione Advantys STB

11 LUB32 Base di potenza TeSys U

12 LUCD18BL Unità di controllo avanzato

14 LU9RFL15 Adattatore di fine linea TeSys U

15 LU9RDD10 Cavo di collegamento bus, diritto/diritto, con un connettore per cavo di 

prolunga bus isola su ciascuna estremità, per segnali bus e alimentazione 

interna, da collegare tra i moduli di comunicazione LULC15 (massimo 1 m 

(39,4 in.) da tagliare in base alle dimensioni della rete).

16 LU9BN11L Collegamento bobina precablata (optional), oppure

17 Connessione standard in 

dotazione al LULC15

Morsettiera plug-in per il comando diretto dei morsetti A1/A2

1 2 3 5 64 7 8 9 10

14

15

11

12

13

16 / 17
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Introduzione
Strumenti software

Per configurare l'applicazione occorrono i seguenti strumenti software. Il loro uso richiede un minimo di 

esperienza in materia.

Rete fieldbus

Protocollo: CANopen

Velocità di trasmissione: 500 kbps

Configurazione della strategia di fallback per TeSys U sulla sottorete STB

Se la comunicazione con il PLC si interrompe, la strategia di fallback permette di azionare il motore in 

modi diversi. Impostare il parametro 682 su uno dei valori seguenti:

La strategia di fallback adatta all'applicazione in oggetto è:

 Valore 1 = congelamento per il motore 1

 Valore 2 = arresto forzato per il motore 2

Nome commerciale Freeware Descrizione

STB SPU 1000 — Advantys Software di configurazione V2.5 per il 

sistema di I/O distribuiti Advantys STB.

UNY SPU EFM CD40 — Unity Pro Extra Large Software di 

programmazione V4.0 per PLC M340.

— File STBNCO2212_0301E.eds Foglio elettronico (EDS) utilizzato dal software di 

configurazione Unity Pro XL per gestire 

correttamente i dispositivi. Scaricare il file .eds 

dal sito www.schneider-electric.com.

— Libreria DFB comprendente 

Ctrl_cmd_u

Controllo/Comando ciclico TeSys U. Scaricare la 

libreria DFB TeSys U dal sito www.schneider-

electric.com

Valore Modalità di fallback Descrizione

0 Disabilitata Nessuna strategia. Scelta non consigliata.

1 Congelamento Quando viene individuata un'interruzione della comunicazione il motore 

mantiene il proprio stato:

 Se in marcia, continua a funzionare.

 Se fermo, rimane fermo.

Le modifiche dello stato di controllo non sono autorizzate. Un nuovo 

comando viene preso in considerazione solo dopo aver ripristinato 

l'interruzione di comunicazione (703.3).

2 Arresto forzato 

(impostazione predefinita)

Il motore viene forzato all'arresto.

Uscita OA1 = 0

Uscita OA3 = 0

3 Nessuna variazione Le modifiche dello stato di controllo sono autorizzate. Un nuovo comando 

viene preso in considerazione anche prima di ripristinare l'interruzione di 

comunicazione (703.3).

4 Marcia avanti forzata Uscita OA1 = 1 (avanti) 

Uscita OA3 = 0

5 Marcia indietro forzata Uscita OA1 = 0

Uscita OA3 = 1 (indietro)
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Configurazione del TeSys U
Contenuto di questo capitolo

Questo capitolo contiene le seguenti sottosezioni:

Impostazioni di LUCA12BL e LUCD18BL

Regolazione della corrente sulle unità di controllo

La figura seguente spiega come regolare la corrente sull'unità di controllo (in questo caso LUCA12BL) 

per mezzo di un cacciavite:

Valori di regolazione della corrente

La tabella seguente illustra le regolazioni per i moduli LUCA12BL (unità di controllo standard) e 

LUCD18BL (unità di controllo avanzato):

Argomento Pagina

Impostazioni di LUCA12BL e LUCD18BL 9

Connettori, impostazione della velocità di trasmissione e dell'indirizzo del modulo LULC15 10

4.00A

LULC15

5.00A

7.00A

9.00A

12.0A

3.00A

LUCA / LUCD
TeSys

LUCA 12BL

24V c

CLASS 10

3 a

Unità di controllo Motore Range di regolazione 

della corrente

Potenza nominale 

del motore

Valore di regolazione della 

corrente = corrente nominale del 

motore

LUCA12BL M1 3...12 A 5,5 kW (7.5 hp) 10,5 A

LUCD18BL M2 4,4...18 A 7,5 kW (10 hp) 14,7 A
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Configurazione del TeSys U
Connettori, impostazione della velocità di trasmissione e dell'indirizzo del modulo LULC15

Presentazione

Connettori sotto il modulo di comunicazione LULC15:

1 Morsettiere di ingresso/uscita e 24 Vdc

2 Bus OUT (uscita logica 1)

3 Bus IN (ingressi logici 1 e 2)

4 Uscite COM, OA1, OA3

Impostazione della velocità di trasmissione e dell'indirizzo del modulo 

I parametri di comunicazione, comprese l'impostazione degli indirizzi e della velocità di trasmissione del 

modulo di comunicazione LULC15, sono definiti automaticamente.

4

3

2

1
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Configurazione di una rete di comunicazione 

con un PLC
Introduzione

Questo capitolo illustra le fasi che consentono di configurare la comunicazione con un PLC.

Per configurare la comunicazione con un Modicon M340 occorrono i 2 tool software indicati di seguito:

 Advantys

 Unity Pro

Contenuto di questo capitolo

Questo capitolo contiene le seguenti sottosezioni:

Argomento Pagina

3.1 Configurazione di TeSys U sulla rete Advantys STB con Advantys e Unity Pro 12

3.2. Configurazione dei DFB con l'applicazione 17
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Configurazione di una rete di comunicazione con un PLC
3.1 Configurazione di TeSys U sulla rete Advantys STB con Advantys e Unity Pro

Procedura di configurazione

1) Scaricare e installare i file EDS

I file EDS devono essere installati in Unity. La tabella seguente descrive la procedura per scaricare e 

installare i file EDS e di icona associati a Tesys U dal sito www.schneider-electric.com.

Passo Azione

1 Collegarsi al sito Schneider Electric www.schneider-electric.com.

2 Nel campo Search digitare Advantys STB.

3 Nella sezione Product Ranges selezionare Advantys STB.

4 Fare clic sulla scheda Download e selezionare Software/Firmware.

5 Selezionare STBNCO2212 CANopen .eds and .dib Files 2/8/06 e scaricare il file 

stbnco2212_canopen_eds_1_2006.zip.

6 Estrarre il contenuto del file stbnco2212_canopen_eds_1_2006.zip sul disco rigido. L'archivio 

compresso contiene il file STBNCO2212_0301E.eds.

7

Dal pulsante Start , selezionare Tutti i programmi, quindi Schneider Electric → Unity Pro → 

Hardware catalog manager.

8 Nella finestra di Hardware Catalog Manager selezionare Edit → Add.

9 Nella finestra visualizzata, selezionare il file STBNCO2212_0301E.eds.

10 Confermare selezionando Open.

11 Nella finestra Device Profile, controllare che nel campo Family sia selezionata la voce Distributed 

I/Os, quindi confermare selezionando OK.

Risultato: il dispositivo viene visualizzato nella finestra di Hardware Catalog Manager.

12 Nella finestra di Hardware Catalog Manager fare clic sul pulsante Build Catalog, quindi su Close.
12 1672608 01/2010



Configurazione di una rete di comunicazione con un PLC
2) Configurazione dell'isola STB con il software Advantys

Di seguito si descrive la procedura di configurazione con il software Advantys.

Passo Azione

1 Avviare il software Advantys V2.5.

2 Fare clic sull'icona STB e selezionare la lingua.

3 Dal menu File creare un nuovo spazio di lavoro comprendente un file isola.

4 Controllare che l'isola sia sbloccata: l'icona della chiave sulla barra degli strumenti non deve essere 

selezionata.

5 Configurare l'isola STB utilizzando i moduli disponibili nella cartella STB - Catalog di Catalog Browser.

Selezionare i seguenti moduli nell'ordine indicato e fare doppio clic su ciascuno:

 Networking → STBNCO2212 - V3.xx per il modulo di interfaccia di rete (NIM) 

 Power → STBPDT3100 - V1.xx per il modulo di distribuzione dell'alimentazione (PDM)

 Digital Output → STBDDO3200 - V1.xx per il modulo I/O Advantys

 Accessories → STBXBE1100 - V1.xx per la fine del segmento (EOS), a condizione che l'ultimo 

modulo sul bus dell'isola sia un dispositivo TeSys U.

Risultato: i moduli selezionati vengono visualizzati sull'editor isole.

NOTA: se il catalogo hardware non contiene i moduli adatti all'applicazione aggiornarlo come segue:

 Collegarsi al sito Schneider Electric www.schneider-electric.com.

 Nel campo Search digitare Advantys Database Update.

 Nella sezione Software selezionare Advantys Database Update V 2.53 for Configuration 

Software.

 Scaricare il file advantys_csw_2501_database_update_253_english.exe.

 Fare doppio clic su advantys_csw_2501_database_update_253_english.exe.

 Seguire la procedura di installazione.

 Nel software Advantys selezionare il comando Options → Settings.

 Alla voce Path settings, impostare il percorso di EDS files import selezionando la cartella del disco 

rigido in cui è stato installato il file .exe.

 Fare clic su OK per chiudere la finestra di dialogo Settings.

6 Aggiungere i 2 sistemi TeSys U nell'ordine seguente selezionando l'etichetta e facendo doppio clic:

 Preferred → TeSys U Sc St - V1.xx per la versione standard di TeSys U

 Preferred → TeSys U Sc Ad - V1.xx per la versione avanzata di TeSys U

NOTA: 

 Le lettere Sc corrispondono a Starter-Controller.

 Le lettere St e Ad indicano rispettivamente unità di controllo Standard e Advanced (avanzata).

7 Aggiungere il dispositivo di fine linea selezionando Accessories → TeSys U LU9RFL15 - V1.xx e 

facendo doppio clic sul nome dell'adattatore di fine linea.
1672608 01/2010 13



Configurazione di una rete di comunicazione con un PLC
3) Configurazione della rete applicativa con il software Unity Pro XL

Continuare la procedura di configurazione con il software Unity Pro XL come descritto di seguito.

8 Fare doppio clic su ogni icona TeSys U nell'ordine. Nella finestra di configurazione visualizzata, 

configurare la strategia di fallback in caso di interruzione della comunicazione: espandere l'elenco 

Setting nella scheda Parameters e selezionare Fallback Strategy (682). Alla voce Configured Value:

 Per TeSys U Sc St, impostare la strategia di fallback in caso di interruzione della comunicazione su 

Frozen nell'elenco a discesa, quindi confermare con OK.

 Per TeSys U Sc Ad mantenere la strategia di fallback per interruzione della comunicazione 

predefinita: Forced Stop.

9 Salvare l'applicazione e fare clic sull'icona Build.

Risultato: la finestra di accesso visualizza il messaggio: “Build completed successfully”.

10 Selezionare File → Export [project name] ed esportare il progetto come file .dcf.

11 Salvare di nuovo l'applicazione e uscire dal software Advantys.

Passo Azione

Passo Azione

1 Lanciare il software Unity Pro XL V4.0.

2 Configurare il processore del PLC Modicon M340:

 Dal menu File creare un nuovo progetto.

 Nella finestra New Project espandere l'elenco Modicon M340 e selezionare BMX P34 2010 (CPU 

340-20 Modbus CANopen).

 Confermare selezionando OK.

3 Dalla vista strutturale del browser progetti selezionare Configuration → 3 : CANopen. 

4 Nella scheda CANopen fare doppio clic sul dispositivo:

Si apre una finestra di dialogo New Device.

5 Nella finestra New Device impostare la configurazione del modulo di interfaccia di rete (NIM) CANopen 

come segue:

 Selezionare CANopen drop → Distributed I/Os → STB_NCO_2212

NOTA: se l'elenco degli I/O distribuiti non contiene il modulo di interfaccia di rete per l'applicazione, 

scaricare e installare i file .eds necessari (vedi pagina 12).

 Impostare Topological Address su 4.

 Confermare selezionando OK.
14 1672608 01/2010



Configurazione di una rete di comunicazione con un PLC
6 Dalla vista strutturale del browser progetti selezionare Configuration → 3 : CANopen → 

4 : CANopen drop → 0.0 : STB_NCO_2212 o fare doppio clic sul nome del modulo di interfaccia di rete 

(NIM). Si apre la schermata STB_NCO_2212 in una nuova scheda.

7 Nella scheda PDO mascherare i PDO vuoti, quindi selezionare il pulsante Import DCF... e cercare il file 

.dcf esportato durante la configurazione dell'applicazione in Advantys.

Risultato: i PDO vengono visualizzati con gli indirizzi topologici.

NOTA: consultare i manuali d'uso TeSys U LULC15 Advantys STB, modulo di comunicazione e Variabili 
di comunicazione TeSys U per ulteriori informazioni sull'assegnazione di nomi significativi agli indirizzi 

topologici.

Esempio: l'applicazione usa i seguenti simboli per programmare il DFB del motore 1 (TeSys U standard):

 Mappa dati di ingresso:

 PDO4: simbolo reg_455_M1 invece di %IW\3.4\0.0.0.96

 Mappa dati di uscita:

 PDO3: simbolo reg_704_M1 invece di %QW\3.4\0.0.0.96

 PDO3: simbolo reg_703_M1 invece di %QW\3.4\0.0.0.97

8 Dalla vista strutturale del browser progetti, selezionare Configuration → 0 : PLC bus → 

0 : BMX XBP 0800 → 0 : BMX P34 2010 → CANopen. Si apre la schermata CANopen communicator 

head in una nuova scheda.

9 Selezionare Build → Rebuild All Project.

NOTA: nell'area Rebuild All Project compare un messaggio riguardante il numero di parole e bit 

IN/OUT riservati. Tornare alla schermata CANopen communicator head e inserire i valori indicati nel 

messaggio.

Configurare le opzioni in base all'applicazione di esempio:

 Impostare la velocità di trasmissione su 500 kBaud.

 Il numero di parole (%MW) deve essere 278 per gli ingressi e 244 per le uscite.

 L'indice della 1a %MW deve essere 0 per gli ingressi e 278 per le uscite.

 Il numero di bit (%M) deve essere 0 per ingressi e uscite.

10 Per convalidare la configurazione selezionare Edit → Validate.

11 Per rigenerare il progetto selezionare Build → Rebuild All Aroject. Quando i valori sono corretti lo stato 

passa da NOT BUILT a BUILT.

12 Salvare l'applicazione con un nome specifico e uscire dal software Unity.

Passo Azione
1672608 01/2010 15



Configurazione di una rete di comunicazione con un PLC
4) Impostare la velocità di trasmissione e l'indirizzo del nodo dell'isola Advantys STB 

I selettori sul NIM STBNCO2212 CANopen consentono di impostare l'indirizzo del nodo e la velocità di 

trasmissione dell'isola Advantys STB.

I 2 selettori si trovano sul frontale del NIM CANopen, sotto la porta di collegamento fieldbus. Ciascun 

selettore dispone di 16 posizioni.

Per impostare la velocità di trasmissione e l'indirizzo del nodo dell'isola Advantys STB procedere come 

segue: 

5) Eseguire il test funzionale della rete di comunicazione, compresi il PLC e i prodotti M340 

Passo Azione

1 Impostare la velocità di trasmissione dell'isola Advantys STB su 500 kBaud ruotando i selettori sul NIM 

STBNCO2212 CANopen nell'ordine indicato:

 Impostare il selettore inferiore (BAUD RATE) su una posizione qualsiasi priva di contrassegni.

 Impostare il selettore superiore (TENS) sulla velocità desiderata: 5

2 Accendere l'isola per abilitare il NIM e leggere le impostazioni della velocità di trasmissione.

3 Spegnere l'isola.

4 Impostare l'indirizzo del nodo dell'isola Advantys STB su 4 ruotando i selettori sul NIM STBNCO2212 

CANopen:

 Impostare il selettore inferiore (ONES) su 4.

 Impostare il selettore superiore (TENS) su 0.

5 Accendere l'isola per abilitare il NIM e leggere le impostazioni dell'indirizzo.

Passo Azione

1 Collegare un cavo dall'isola CANopen al PLC M340.

2 Sulla porta USB del PC collegare un cavo (ad esempio TSXPCX3030) diretto al PLC M340.

3 Accendere il PLC M340.

4 Fare clic su Connect nel software Unity Pro XL.

5 Selezionare il menu PLC: si apre la finestra Transfer Project to PLC. Fare clic sul pulsante Transfer.

6 Accendere i 2 sistemi TeSys U: il LED verde COM sul frontale del modulo LULC15 lampeggia, quindi 

rimane acceso. La comunicazione funziona correttamente.
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Configurazione di una rete di comunicazione con un PLC
3.2. Configurazione dei DFB con l'applicazione

Presentazione

I DFB (Derived Function Blocks, blocchi funzione derivati) TeSys sono stati sviluppati per semplificare e 

ottimizzare l'integrazione dei controller avviatori TeSys U nelle applicazioni PLC.

Il DFB Ctrl_cmd_u è dedicato al controllo e comando di un controller avviatore TeSys U singolo (fino a 

32 A/15 kW o 20 hp) tramite scambi di dati ciclici su una rete CANopen.

Fasi di configurazione dei DFB:

1. Scaricare i file DFB

2. Installare i DFB in Unity Pro

3. Cercare il progetto e l'applicazione DFB in Unity Pro

Per ulteriori informazioni vedere il manuale d'uso TeSys DFB V2 per Unity Pro.

1) Scaricare i file DFB

La tabella seguente spiega come scaricare i file TeSys DFB dal sito www.schneider-electric.com:

2) Installare i DFB in Unity Pro

3) Cercare il progetto e l'applicazione DFB in Unity Pro

Passo Azione

1 Collegarsi al sito Schneider Electric: www.schneider-electric.com

2 Nel campo Search digitare TeSys U.

3 Nella sezione Product Ranges selezionare TeSys U.

4 Fare clic sulla scheda Download e selezionare Software/Firmware.

5 Selezionare TeSys DFB Library for UnityPro e scaricare il file .zip sul disco rigido.

Passo Azione

1 Estrarre il contenuto del file tesys library for unitypro-1.0.2.zip sul disco rigido, quindi fare doppio clic sul 

file Setup.exe.

2 Selezionare la lingua di installazione.

3 Nella procedura guidata per la libreria TeSys selezionare Next 5 volte.

4 Accettare i termini dell'accordo di licenza, quindi fare clic su Next.

5 Inserire le informazioni personali, quindi selezionare due volte Next.

6 Selezionare una o più lingue per l'applicazione, compresa la lingua predefinita, quindi fare clic su Next.

7 Fare clic su Install per iniziare l'installazione.

8 Nella finestra visualizzata, selezionare la versione della libreria Unity Pro e la famiglia da installare.

9 Viene visualizzata una finestra di dialogo con il messaggio: “The Installation Wizard has successfully 

installed TeSys Library”. Uscire dalla procedura guidata.

Passo Azione

1 Avviare il software Unity Pro.

2 Dal menu Tools selezionare il sottomenu Type Library Manager. Selezionare il pulsante Access 

Assistant. Selezionare la cartella Ctrl_cmd_u e spostarla nell'area di destra, denominata Objects to get:

Fare clic su Copy into project.

3 Fare clic a destra nella finestra, quindi selezionare FFB Input Assistant.... Si apre una finestra di 

dialogo Function Input Assistant vuota.
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Configurazione di una rete di comunicazione con un PLC
Caratteristiche degli ingressi

La tabella seguente descrive gli ingressi del DFB e la loro disponibilità in base all'unità di controllo:

Caratteristiche delle uscite

La tabella seguente descrive le uscite del DFB e la loro disponibilità in base all'unità di controllo:

4 Selezionare l'icona accanto al campo FFB type:

5 Nella finestra di dialogo Function Input Assistant: FFB Selection, sfogliare fino al DFB Ctrl_cmd_u.

6 Selezionare Ctrl_cmd_u, quindi confermare con OK.

7 Fare clic in un punto qualsiasi della finestra: viene visualizzata la rappresentazione grafica del DFB.

Passo Azione

Ingresso Tipo Range Valore 

predefinito

Descrizione LUCA LUCD

Reg_455 INT 0...65535 0 Per collegamento al registro 455 degli 

ingressi dati ciclici

√ √

Run_fwd EBOOL 0...1 0 Comando motore marcia avanti √ √

Run_rev EBOOL 0...1 0 Comando motore marcia indietro √ √

Rst_flt EBOOL 0...1 0 Ripristino dopo guasto (in caso di guasto del 

modulo di comunicazione, riporta il modulo 

alle impostazioni di fabbrica)

√ √

Rst_warn EBOOL 0...1 0 Ripristino allarme (ad esempio interruzione 

della comunicazione)

√ √

Ther_ov_test EBOOL 0...1 0 Test automatico del guasto da sovraccarico 

termico

  

Trip_tst EBOOL 0...1 0 Test di disinnesto per sovracorrente tramite 

bus di comunicazione

  

Uscita Tipo Range Valore 

predefinito

Descrizione LUCA LUCD

Reg_704 INT 0...65535 0 Per collegamento al registro 704 delle uscite 

dati ciclici

√ √

Reg_703 INT 0...65535 0 Per collegamento al registro 703 delle uscite 

dati ciclici

√ √

Ready EBOOL 0...1 0 Sistema pronto: la manopola è in posizione 

On e non vi sono guasti

√ √

Closed EBOOL 0...1 0 Stato del polo: chiuso √ √

Tripped EBOOL 0...1 0 Sistema intervenuto: la manopola è in 

posizione Trip

√ √

Fault EBOOL 0...1 0 Tutti i guasti √ √

Alarm EBOOL 0...1 0 Tutti gli allarmi √ √

Rst_auth EBOOL 0...1 0 Ripristino errore autorizzato  √
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Configurazione di una rete di comunicazione con un PLC
Programmazione del DFB 1 per il motore 1

Starting EBOOL 0...1 0 Avviamento in corso:

1 = corrente in salita superiore al 10 % FLA

0 = corrente in discesa inferiore al 150 % FLA

 √

Running EBOOL 0...1 0 Motore in marcia con rilevamento di corrente, 

se superiore al 10 % FLA

 √

Avg_curr INT 0...200 0 Corrente media motore (% FLA)  √

Uscita Tipo Range Valore 

predefinito

Descrizione LUCA LUCD

Passo Azione

1 Assegnare un nome ai registri PLC (%IW..., %QW...) corrispondenti ai registri TeSys U (455, 703 e 704).

Per il nodo 1 (TeSys U_Sc_St):

 Reg_455_M1: %IW\3.4\0.0.0.96

 Reg_704_M1: %QW\3.4\0.0.0.96

 Reg_703_M1: %QW\3.4\0.0.0.97

2 Collegare l'ingresso Run_fw DFB1 alla condizione di avviamento del motore 1.

3 Collegare le uscite DFB 1 alle variabili PLC da usare nel programma:

 Uscita DFB1 chiusa = posizione del contattore KM1

 Uscita DFB1 intervenuta = posizione intervenuta di Q1 TeSys U

4 Controllare che il DFB 1 del motore 1 venga visualizzato come segue:

1 Non applicabile

2 Applicabile, ma non usato; può essere gestito dall'applicazione PLC
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Configurazione di una rete di comunicazione con un PLC
Programmazione del DFB 2 per il motore 2

Passo Azione

1 Assegnare un nome ai registri PLC (%IW..., %QW...) corrispondenti ai registri TeSys U (455, 703 e 704).

Per il nodo 2 (TeSys U_Sc_Ad):

 Reg_455_M2: %IW\3.4\0.0.0.98

 Reg_704_M2: %QW\3.4\0.0.0.99

 Reg_703_M2: %QW\3.4\0.0.0.100

2 Collegare l'ingresso Run_fw DFB 2 alla condizione di avviamento del motore 2.

3 Collegare le uscite DFB 2 alle variabili PLC da usare nel programma:

 Uscita DFB 2 chiusa = posizione del contattore KM2

 Uscita DFB 2 intervenuta = posizione intervenuta di Q2 TeSys U

4 Collegare l'uscita Avg_curr DFB 2 a un registro PLC per usare la corrente media del motore 2 nel 

programma.

5 Controllare che il DFB 2 del motore 2 venga visualizzato come segue:

1 Non applicabile

2 Applicabile, ma non usato; può essere gestito dall'applicazione PLC
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